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Limited Warranty

As Esper is provided free for evaluation purposes, and once registered the program can be 
updated freely at any time by electronic means, no warranty for replacement of media or 
programs is offered, as none is required.

IN ANY EVENT, ALL IMPLIED WARRANTIES ON THE SOFTWARE AND MANUALS, 
INCLUDING ANY IMPLIED WARRANTIES ON MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO THIRTY (30) DAYS FROM 
THE DATE OF THE ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.

ThoughtWare has tested the software and reviewed the manual but ThoughtWare makes no 
warranty or representation, expressed or implied, with respect to software, its quality, 
performance, merchantability, or fitness for a particular purpose. That is, Esper is sold "as is", 
and you are assuming the entire risk as to its quality and performance. In no event will 
ThoughtWare be liable for direct, indirect, special, incidental, or consequential damages 
resulting from any defect in the software or its documentation, even if advised of the 
possibility of such damages.

Some jurisdictions do not allow limitation of warranties or their duration and grant you 
additional "rights". ThoughtWare recognises that this is unjustified initiation of force by such 
governments and rejects all and any such laws, and will not trade under such duress. If you 
don't agree with ThoughtWare's warranty policy, your protection is to not use the product.

The Warranty and remedies set forth above are exclusive and in lieu of all others, oral or 
written, express or implied. 

Copyrights and Trademarks

Esper is © 1996, 1998 by ThoughtWare and 1999-2000 by ThoughtWare Australia Pty Ltd

Based on Hi-PsiQ © 1991, 1992 by ThoughtWare.

This Instruction Manual is © 1992, 1996, 1998-2000 by ThoughtWare Australia.

Esper and ThoughtWare are trademarks of ThoughtWare Australia Pty Ltd.

Copies of Esper may be distributed for evaluation purposes but not for profit: provided that all 
copyright notices, author attributions, support files and this Manual are included.

Apple, Macintosh and PowerPC are registered trademarks of Apple Computer, Inc.
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Do Psychic Abilities Exist?
For centuries, people have been fascinated by the possibility that humans, and even 

animals, can perceive or influence things directly by the power of their minds. Throughout 
history, those suspected of such powers have been alternately revered, feared and persecuted.

With the advent of science, it became possible to study these phenomena objectively. Are 
they real, or the result of coincidence or fraud?  If they are real, how do they work?  A new 
branch of science, parapsychology, arose to address these questions.

Despite decades of research by parapsychologists, the evidence remains tantalisingly 
inconclusive. Many interesting results have been observed, and people of apparently unusual 
powers have been studied. This has been convincing to many:  but so far, the evidence has 
not been strong enough to convince skeptics or mainstream scientists.

It appears that psychic abilities, if real, are unreliable, coming and going unpredictably. 
Many people theorise that testing in scientific laboratories, with its artificial environment, 
stressful conditions, and sometimes skeptical staff, is bound to fail with something so 
dependent on a person’s mental state.

Why Esper?
Esper has been designed as a valid scientific program for testing (and even training!) 

psychic abilities in the privacy and comfort of your home, at your own pace and according to 
your own preferences. The tests themselves are easy and fun, and the computer does all the 
hard work: it keeps all of your records automatically, and can estimate your “PsiQ” as well as 
doing a variety of powerful statistical analyses to measure your ESP abilities.

By being an easy yet powerful program that can be used at home at your convenience, 
Esper avoids the major problems of “formal” tests by parapsychologists. There is no stress, 
pressure or inconvenience, so you can test and develop your psychic powers under optimum 
conditions. You can do as much or as little scientific analysis of your results as interests you.

What are Psychic Abilities?
Psychic abilities are also called “extrasensory perception” (ESP) or simply “psi”. 

Parapsychologists have classified psi into a number of types. The four major kinds are 
clairvoyance, precognition, telepathy and psychokinesis. All of these are tested by Esper.

(1) Clairvoyance is the ability to “see” things which are not visible to your normal senses. If 
you have ever “known” where a lost object is, or who the person who just rang your 
doorbell is, then you may have experienced clairvoyance. “Psychometry”, the ability to 
know things about people or events by handling a related object, is a type of 
clairvoyance. Note that the term “clairvoyant” is often used loosely, to include any 
psychic including one who can see the future: Esper uses the stricter meaning.

(2) Precognition is the power to see what will happen in the future. Fortune-telling, 
prophecy and dreams which come true are all examples of precognition.

(3) Telepathy is mind-reading. Have you ever known what your friends are thinking, or have 
two of you thought the same thing at once?  Perhaps this was telepathy.

Esper™  Manual 1



(4) Psychokinesis is the ability to influence physical events with the power of your mind. For 
example, to influence the roll of dice, to bend spoons by thought, or to levitate objects (or 
yourself!) is to use psychokinesis. Psychokinesis is sometimes called “telekinesis”, 
meaning action at a distance, but the former term is more correct.

How are Psychic Powers Tested Scientifically?
The first systematic scientific studies of ESP were done by Dr J. B. Rhine, who pioneered 

a technique still used today. This method uses packs of 25 cards consisting of five each of five 
symbols (often being a square, circle, cross, star and wavy lines). The deck is shuffled, and the 
test subject must “guess” the cards. The details of the method depend on the psychic ability 
being tested.

To test clairvoyance, the deck is shuffled, and the person must determine the order of the 
cards, usually by saying which card is on top as the tester goes through the deck. For a valid 
test, the scientist should not know what the cards are until after the test subject has given his 
or her answer, in order to avoid the possibility of giving unconscious clues.

For precognition, the subject writes down what order he or she thinks the cards will be 
dealt in. The deck is then shuffled, and the order of cards compared to the predictions.

Testing telepathy is similar to testing clairvoyance, except that another person (the 
scientist, or a third party) looks at each card as it comes up, and by concentrating on it, tries to 
“transmit” the information to the test subject.

With psychokinesis, dice rather than cards are usually used. The person being tested 
attempts to influence the result of the dice rolls. More sophisticated equipment can be used 
too, such as direct measurements of the force exerted by the person’s mind on an object.

Of course, there are other ways to study psychic abilities, but the above are the simplest 
conceptually, and more sophisticated methods have not given more conclusive results.

How Realistic are Scientific ESP Tests in General?
The tests described above are more rigidly defined than the events which people 

generally ascribe to ESP. However, the complexity of the latter makes their interpretation 
extremely difficult. How do you know whether your dream coming true was a psychic event, 
or just coincidence?  (How many dreams have you had which didn’t come true?)  How do 
you measure how close your feelings actually were to the events which occurred?  How 
reliable is your memory?

Questions such as these are what prompt scientific inquiry into psychic events. Indeed, 
skeptics argue that all of the anecdotal evidence of ESP can be explained by coincidence, 
improvement of stories in the telling, and the fact that people will remember their “hits” more 
readily than their “misses”!

It is only by designing a simple system, such as ESP-cards, that psychic phenomena can 
truly be measured and proven. With such tests, the powerful tools of statistics can be brought 
to bear to test whether the results are due to something real, or just the result of chance and 
luck.

Perhaps psychic abilities are so selective that they cannot “read” the results of simple 
card tests, though even inefficient abilities would be revealed by sufficient numbers of tests. If 
you believe this, then perhaps the only testing Esper does that you’ll be interested in will be 
of telepathy, in which the use of a human “transmitter” makes the tests directly relevant to 
normal life.
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How Esper Tests Psychic Abilities
Esper is based on ESP-card tests. Your computer “deals” a deck of 25 cards consisting of 

5 different symbols, and you have to guess what they are.

The computer does not have the limitation of a physical deck of cards:  it deals its 25 
cards from an “infinite” deck. That is, the cards are truly random: each card dealt has a one in 
five chance of being any one symbol, and the chance of any symbol appearing is not 
influenced by previous cards. This means that you can’t improve your score by “counting 
cards” (if the computer always dealt five of each card, you could improve your score by 
consciously or unconsciously keeping track of which cards show up). By using an infinite 
deck, Esper can give you instant feedback about whether you are right or wrong, without 
invalidating the tests. This is a powerful tool for actually training and improving any psychic 
powers you may have!

Clairvoyance: the computer shuffles and deals 25 cards “face down”. Then you go 
through one by one, choosing which symbol you think each card is. You have the option to 
draw the card on a covered part of the screen, or merely show the memory location of the 
card’s identity.

Precognition: you predict which symbols will be shown, then the computer shuffles and 
deals. This may be card by card, or the whole deck at once.

Telepathy: a friend watches the screen while you hold the computer keyboard. As the 
computer shows each card in turn, your friend must concentrate on it, and you must read his 
or her mind!

Psychokinesis: you try to influence or change the computer’s choices. Each time, the 
computer shuffles the cards until you click on the one you have been concentrating on, then 
waits for a specified time while you try to change its choice. (In the DOS version of Esper, you 
pick one symbol at the start of the test, to use for all 25 cards: then each time, the computer 
shuffles the next card until you tell it to stop).

You can set a number of options separately for each test. The type of feedback of your 
results, and whether there is sound, can be chosen. The details are given later in the manual 
(see The File Menu: Options).

How Realistic are Esper’s Tests?
A computerised ESP test can’t be exactly the same as one run by a person. However, in 

general the tests are as realistic as any other scientific ESP test.

Clairvoyance: tests in which the cards are drawn on the screen but hidden, are directly 
comparable to normal tests. There is actually a picture of the card there, which is as real  
physically as a printed image on cardboard. You might question the validity of the 
clairvoyance tests when the cards are not shown on the screen. However, the electronic state 
of the computer’s memory is as real as any other phenomenon: and as no-one knows how 
psychic abilities actually work, one can’t just claim they cannot detect it. Simply do the type 
of test you feel most comfortable with.

Precognition: these tests are quite realistic, as you are trying to predict which images will 
actually appear on the screen after you’ve made your choice (depending on the feedback 
options you have chosen).

Telepathy: these are the same as normal tests, as you are trying to read a person’s mind.

Psychokinesis: these tests are the furthest from “standard”, as you are not manipulating 
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solid objects like dice, but the computer’s internal workings and/or memory. On the other 
hand, this task is actually easier than mentally altering the roll of dice or moving an object: it 
takes far more force to move a solid object, than to move a few electrons in a computer chip!  
It may well be that the ability to influence a computer may not imply the ability to move a 
solid object, and vice-versa: but scientifically it would be just as fascinating, and just as 
important a discovery!

Interactions Between Different Abilities
It is not always possible to distinguish between different psychic abilities in any particular 

test. For example, in theory a good “clairvoyance” result might actually be from precognitive 
sensing of the cards shown after your choice; a good “telepathy” score might be 
clairvoyance; and a good “psychokinesis” result might be due to accurate prediction of the 
cards to be dealt!  In general, however, you could distinguish these by comparing your scores 
in the different tests. Personally, if my ESP were so good that I had this problem, I wouldn’t 
care about such details!

Training Psychic Abilities with Esper
Esper is designed not only to test ESP, but also to develop and improve any latent 

abilities you may have. It does this by utilising your natural learning processes.

You learn any natural ability - how to walk, talk, or ride a bike - by a process of trial and 
error, with actions leading to success being reinforced, and failed actions being suppressed. 
Psychologists call this “conditioning”. Esper taps into this natural process.

The most effective way to use Esper is with the “Instant Feedback” option and the 
sound on. Under these conditions, you immediately know your result, and are rewarded with a 
tune if your are right, or get bleeped if you are wrong. If you have any latent psi abilities, this 
is the best way to develop them. You don’t need to worry about what mental processes are 
involved, any more than you need worry about exactly how your brain controls your muscles 
when you walk.

Don’t worry if you do badly at first. Consider how long it takes to learn to walk or 
become proficient at a sport, and how poorly developed and unreliable psychic abilities 
appear to be. Persistence will be necessary!

Your PsiQ
Registered copies of Esper estimate your PsiQ when analysing your total scores and 

period statistics. PsiQ (“Psi Quotient”) is analogous to IQ (“Intelligence Quotient”), and is an 
indicative estimate of your psi abilities.

PsiQ is calculated by analogy to IQ according to the Stanford-Binet scale (a standard IQ 
scale). Each standard deviation from the population average corresponds to 16 IQ points. 
Valid IQ tests depend on properly conducted population studies. Since such studies are not 
available for ESP, Esper estimates PsiQ simply by calculating how many standard deviations 
(based on the binomial statistic) your score is from the average (5 out of 25).

Note that Esper’s PsiQ is more accurate the more tests you have done: one or a few tests 
will not give an accurate result.

In addition to your PsiQ, Esper will indicate how good that PsiQ is: such as average, 
brilliant or genius. Your “PsiQ” is given for fun not as a scientifically recognised 
measurement, as no population statistics are available for ESP abilities!
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The Esper Symbols
ESP cards generally use rather boring geometric symbols. To add to the enjoyment of the 

tests, Esper uses more interesting symbols. These are shown below, though the exact forms 
and colours depend on your computer.

Pyramid:  The pyramids of ancient Egypt have long fascinated mankind, with 
their vast size and grand symmetry. The burial places of pharaohs, they have 
held great men, great treasures, and the hopes of immortality. Thus, many people 
ascribe mystical powers to pyramids.

Ankh:  Another symbol from ancient Egypt, the ankh is a looped cross 
symbolising life, the soul and regeneration.

Yin Yang: In ancient Chinese philosophy, these are the paired fundamental 
principles of the universe. They symbolise intertwined, interdependent 
opposites: male & female, active & passive, day & night, good & evil.

Grail:  According to legend, the chalice used by Jesus at the Last Supper, in 
which Joseph of Arimathaea received the last drops of the blood of Christ at the 
crucifixion. A symbol of a lost, pure kind of Christianity, it was the object of an 
enduring search by the legendary Knights of the Round Table.

Crystal:  The beauty, symmetry and internal fire of crystals have long fascinated 
mankind. New Age beliefs credit crystals with mystical powers of focusing and 
directing psychic energies.

Statistics
As a scientific program, Esper does a variety of statistical analyses of your results. Every 

time you do a test, it calculates the probability that your score is simply due to chance. The 
lower this probability, the higher the likelihood that your result is due to skill rather than luck. 
In statistics, a probability of less than 1 in 20 (P < 0.05) generally is regarded as significant. 
However, you must take the total number of tests into account: if you do 100 tests, you can 
expect such a score to occur 5 times!  The “expected” score in any test is 5 out of 25. The 
better your score compared to this, the more likely it is that you have psychic abilities. 

In addition, registered copies of Esper save the result of every test (except Trial runs), and 
can perform a range of more sophisticated analyses on this saved data. It can analyse your 
overall results, test selected portions of your results, compare different times and options, and 
graph your progress. If you want to do further analyses using other programs, it can also 
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extract your detailed records and save them as a text file for that purpose.

The good news is that you don’t need to know anything about statistics or science to use 
Esper. You don’t even have to do any analyses if you don’t want to, but they’re there if you 
want them.

Computer-Specific Instructions
The information in this manual consists of general background and instructions for the 

use of Esper. If further detailed instructions for using Esper on your particular brand of 
computer are needed, these are provided by the “Help” item in the “Special” menu.
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General Introduction
Esper is designed to be easy to use. To this end, it uses a windows, pull-down menu and 

mouse-based interface.

The program is easiest to use with a mouse. On computers for which a mouse is not 
standard equipment, the pointer can be moved using the keyboard arrows or with a pointing 
device such as a joystick, and all commands have keyboard equivalents. Keyboard 
equivalents are either the first letter or number of the item in question, or as indicated. To 
“select” an item on a “mouseless” machine, you either click on it with the joystick, move the 
pointer to it and press the Return key, or press its keyboard equivalent. Unavailable or invalid 
items are faded.

The primary options are shown in a menu bar at the top of the screen. Selecting one of 
these pulls down the corresponding menu, from which you can choose what to do.

After you have made a menu selection, further options may be presented to you. These 
may be options to set, fields to enter data (e.g., a word or number), or action commands. If data 
entry is required, then selecting that item prompts you to type in your information.

On graphics/mouse oriented machines such as the Apple Macintosh, the normal 
conventions are followed. On other machines, details on the user interface are given by the 
Help function.

How to do the Tests
The five card symbols are drawn at the top of the window. Each card also has an id 

number from one to five, shown on the card. In addition, at the beginning of each test there is 
a sixth, “Quit” button. To select a card or Quit, click on it using the mouse or other graphics 
pointing device, or press the appropriate number. The card or button will flash. If you are 
using a mouse, you can change your mind by dragging the mouse cursor off the card before 
releasing the mouse button.

You can only quit a test at the start. Once you have selected your first card, the Quit 
button disappears. This is to ensure the scientific validity of the test: you can’t be allowed to 
quit in the middle of a test simply because you aren’t doing well!  You should only do a test if 
you feel confident and relaxed. If you have any doubts, do not do a test: do a Trial instead. A 
scientific test demands that you decide your mental readiness before you start.

Your cards are scored according to the feedback options you select. Normally, if your 
choice is correct the computer plays a tune and highlights the card; otherwise it simply bleeps.

When you have completed the test (25 cards), the computer shows your score and 
calculates the probability that your result is due to chance. It also gives the cumulative results 
for your current series of consecutive tests and for your totals to date, and your estimated PsiQ 
based on those results (if you have registered). The cards chosen and dealt remain visible for 
reference. You then have the option to continue testing or to return to the main menu.

The details of how to do the individual tests are given in the section on the Test menu.

Installation and Copying
Esper is sold as “Shareware” and has no copy protection. ThoughtWare retains 
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copyright, but relies on the honesty of the users for payment. There are no restrictions on how 
many copies of the program you make for your own use or for others, except that copies 
cannot be sold without the prior express written consent of ThoughtWare, and copies that are 
used regularly should be paid for.

If you have downloaded Esper as a self-extracting archive, simply double-click on the 
archive and provide the information requested (normally, where you want Esper to be placed). 
If you receive Esper already uncompressed, it can be installed on a hard disk simply by 
transferring all its files and directories into a subdirectory or folder on your hard disk.

Make sure that you do not change the names and directory hierarchies, or Esper won’t be 
able to find all its vital data. Also ensure that the number of characters in the full path name of 
your data file (e.g., MyHardDisk:Games:ESP;My Data)is less than 255 characters.

Saving your Data
Your results are saved automatically on disk. You can have as many different data files as 

you want, though in general one per person is best. Esper remembers the last data file it was 
using and will automatically start up with it active (unless you run Esper by deliberately 
opening another data file).

The Primary Screen
The main screen of Esper contains a menu bar at the top of the screen; various bits of 

information in the middle; and the name of the current player at the bottom or as the title of 
the window, depending on the computer type.

The primary menus are “File”, “Test”, “Analysis” and “Special”. These are described in 
detail in the following sections. Each section describes in order the various menu items of the 
appropriate menu. Selecting a menu item may present you with a secondary screen, allowing 
you to set options relevant to the menu item chosen. These are also described in the following 
sections. When the menu action is finished, you will be returned to the Primary Screen and can 
make your next choice.

Selecting “About Esper…” from the Apple Menu on the Macintosh will give some basic 
information on Esper.
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This menu relates to your disk records. It lets you do Trial runs, create new player files, 
open old ones, change the option settings of the current player, and quit Esper.

Trial
If you run Esper without specifying a data file, you automatically begin with this option 

active unless you quit the previous run with a file open.

“Trial” allows you to play and experiment with the tests without saving your results to 
disk. It is a good idea to get the feel of the tests before commencing real testing. Trial runs are 
the same as real tests except that, as the results are not saved, the “Analysis” menu is 
unavailable.

Once you start a “real” test, you cannot back out until all 25 cards have been dealt. So if 
you want to practise, or you don’t feel “right”, then use the Trial option. That way, any bad 
results won’t be added to your stored records and reduce your PsiQ!

New Player
Use this option to start a new data file. You will be asked to enter the name you want to 

use. On appropriate computers, you do this in a file window similar to that in Old Player, so 
that you can specify which disk and/or directory you want. This item is inactive with 
unregistered programs.

Subsequent tests will be saved automatically to your new file, until you open another one 
or return to Trial.

You can use any name that is a legal file name for your computer’s system. You will be 
warned if that file name already exists. If you are using MS-DOS, do not use a filename 
extension (Esper adds its own). Excess characters are ignored.

Old Player
Once you have created a data file, you can reopen it at any time using this option. Choose 

this menu item when you want to do some more “real” tests, or analyse the existing data for 
that player. This item is inactive with unregistered programs.

If you select this item, you will be given a file window with a list of valid data files to 
choose from. The file window also allows you to change disks and to move through and 
across subdirectory trees, if your computer system supports them.

Options
When you first do a particular test as a new player, Esper asks you to set your preferences 

for that type of test. You can set different preferences for the different psi tests if you like. If 
you want to change any of these preferences at a later time, simply use the Options menu item, 
as often as you wish.

You will be asked to select which psychic ability’s test options you want to change, or 
quit. If you choose one, you will be given a window with the available options:
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Name

This shows the player (file) name, and allows you to rename it. You can change it to any 
legal file name except “Trial”, which is reserved, and preexisting file names.

Feedback

Instant: This is the option you will probably want to use most. Each time you choose 
a card, the computer will reveal the actual card beside it. If you are correct, 
the card will be highlighted and a tune will be played.

Delayed: The real cards will be shown only after you have completed all 25 choices.

Right/Wrong: The real cards will remain hidden, but after each of your choices you will be 
told if you are right or wrong: correct cards will be highlighted and the tune 
will be played.

None: No indication of the real cards, or which ones you get right, will be given. 
Only your final score will be shown, when you have finished the test.

Sound Level

Specify whether you want the sounds to play, or not. On the Apple Macintosh, you can 
specify separately whether you want sounds played when the cards are being marked (the 
“tune” and “bleep”), and/or when the cards are being shuffled (other machines do not play 
sounds when shuffling).

Print Card on Screen

This option is available only for clairvoyance. If set, each card will be drawn on the upper 
right of the screen, and you will have to cover that area with something opaque. A piece of 
blackened “Post-It™” is ideal as it is easily removed afterwards.

Seconds to Try Altering Card

This option is only for psychokinesis. If you want to try changing the computer’s choice 
after it is made (that is, to alter the card’s identification number stored in the computer’s 
memory), enter the time in seconds during which you will try to do so. A few seconds is a 
suitable time; the maximum time you can set is 25 seconds. Set the time to zero if you only 
wish to influence the computer’s choices while they are being made. Note that during a test, 
you can abort the delay at any time by pressing the space bar. This is handy if you find you 
have set the delay too long.

Page Setup…
This is available only in the Macintosh and Windows versions. It brings up the standard 

page setup dialog for printing.

Print…
This is available only in the Macintosh and Windows versions. If the active window 

allows printing (e.g., the statistics windows), this item is active and allows you to print the 
information. (On other computers, printing and exporting are specified by buttons when 
setting up the analyses.)
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Export…
This is available only in the Macintosh and Windows versions. If the active window 

allows printing (e.g., the statistics windows), it is active and allows you to export the 
information to disk. It is exported as text except for graphs, which are exported as graphics 
files (PICT on the Macintosh).

Quit
This will quit from Esper and return you to your computer's operating system. Always exit 

Esper via this menu item: never quit by just turning the power off or resetting it, as you might 
lose some or all of your saved data!
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This is the menu for testing your psychic abilities, from which you select which psi ability 
to test. If it is the first time that the current player is doing that test, or you hold down the 
option key (Macintosh only) while selecting it from the menu, you will first be asked to 
indicate your preferences for that test (see the Options item of the File Menu for details). 
Otherwise, you will go straight to the test.

Shuffling of cards is indicated by rapidly changing card symbols. Except for 
psychokinesis, the symbols shown do not necessarily bear any resemblance to the actual order 
which will be dealt. This is to prevent subconscious cues invalidating the tests.

Clairvoyance
In this test, the cards are shuffled and dealt “face down”. Card by card, a “blank” or 

“query” card is shown next to the current position, and you must select which card you think 
is there. Depending on the options you have set, the actual card may be shown after you 
make your choice (see the description of the Options item of the File menu for details).

If each card will be drawn on the screen, you will be warned to cover that part of the 
screen before the test commences. You can also cancel the test at this stage if you want. If the 
cards are not to be shown, the computer will tell you the locations in its memory where the 
card’s identity number and (if appropriate) a copy of its picture are held.

Precognition
You must predict what the computer’s choices will be. Esper will wait for each selection 

in turn. If you have specified instant feedback, then immediately after each choice the 
computer will shuffle the cards and deal one. Otherwise, it will shuffle and deal all 25 cards 
after you make your final choice.

Telepathy
Telepathy is the only test which requires another person. Computers don’t have a mind to 

read (not yet, anyway)!  As the cards must be shown on the screen for the “transmitter” to 
read, you will have to arrange the computer so that he or she can see the screen and you 
can’t, while you control the keyboard. The computer will shuffle and deal 25 cards, as for 
Clairvoyance. Each card will then be shown in turn. Your friend should concentrate on the 
displayed card until you indicate your choice by pressing the appropriate number. Make sure 
that you can’t see what is on the screen - mirrors in strategic locations are not allowed!

Psychokinesis
In this test, you try to influence or change the computer’s choices.

Macintosh and Windows: Each time, the computer shuffles the cards until you click on 
the one you have chosen. It then waits for the specified delay period (if any), during which 
you can attempt to change its choice, before showing the result or starting at the next card.

Others: You select one card at the start of the test and use it for all 25 cards. The other 
cards will be faded or turned over. When you have made your choice, the computer will 
shuffle cards until you select the “Stop Shuffling” button. When you select the button, the 
computer stops shuffling and waits for the specified time (if any: set as an option), before 
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displaying its choice.

The cards shown during the shuffle are the computer’s actual choices, but  “freezing” the 
shuffle only shows you the previous choice (to prevent cheating by repeatedly “unselecting” 
the button until the chosen card appears). Thus, high psychokinetic power would be 
indicated by the unusually frequent appearance of your chosen card. 

If you have specified a time in which to change the computer’s choice, the memory 
location at which the choice is held is shown as a psychological aid.
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The analysis menu provides for the main statistical analyses of your stored results. This 
menu is unavailable if you have selected “Trial” rather than a player test, as there are no 
stored results, and with unregistered programs. Details of the statistics involved are given in 
the Appendix, for interested readers.

You will see that the statistical tests are referred to as “1-tailed” or “2-tailed”. This is 
because results can differ in two directions, greater or lesser: you use a “1–tailed” test when 
you expect the results to be in a particular direction, and a 2–tailed test otherwise. Further 
discussion of tailing can be found in the Appendix.

Esper records these cumulative totals: all cards dealt by the computer, all cards chosen by 
you, and the number of correct cards of each symbol. In addition, it records your score in each 
test plus the options used in that test. The only limitation is that with psychokinesis, it records 
whether or not you set a delay interval, but not the actual interval (it does this to save disk 
space). With these comprehensive records, a number of analyses are possible.

For each analysis, a set of options is presented. You choose which psi ability you want to 
analyse, and other options as required for the particular analysis. On non-Macintosh, non-
Windows machines, you also select where you want the output sent, Options which are 
unavailable or unsuitable for your particular case cannot be selected; if numbers you have 
entered (for example, in specifying a range of tests to look at) are invalid, you will not be able 
to select the “OK” button. The computer will automatically choose certain options and retain 
your last choices of ESP ability and output device, but you can change these as required.
Macintosh and Windows Versions

Analyses are shown in a window on the screen. You can then print them or export them 
to disk using the File menu, if desired.
Other Versions

Output may be sent to one of three places: the screen, the printer, or the disk:

Screen: The results are displayed on your computer screen. Each time the page is filled, 
the computer will wait to be prompted before continuing. You can abort the output by using 
your computer’s standard break command.

Printer: This prints out your results if you want a record on paper. If there is an error 
initialising your printer, the output generally reverts to the screen.

Disk: Your output will be sent to a disk file. This is useful if you want to incorporate 
your results into your own documents, such as a word-processed report. Once you have 
named an output file (done similarly to setting up a New Player), subsequent disk output is 
appended to the end of that file. If you want to send it to another file, simply double-click on 
the disk option button (or click on it once if it is already selected). Note: bit-mapped graphics 
files used for graphs cannot be appended to text files or to each other. In these cases, you 
must specify a new file for each one, and a repeated file name will be overwritten, not added 
to.

When the output is completed, you will be presented with four choices: to repeat the 
output on any of the three output devices, or to quit. The main purpose of this is to let you 
preview the results on the screen before printing or saving them. If you select the same output 
device as before, you will be given the opportunity to change the options you set.
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Analyse Totals
This analyses your cumulative totals, showing the probabilities that your scores are by 

chance, for each card symbol and overall, and the PsiQ which your overall score corresponds 
to. It also indicates how random your and the computer’s choices of the five symbols are. For 
this it uses the binomial and/or normal distribution statistics, as indicated on the output.

If you are favouring or avoiding particular symbols (and the computer is not), then you 
have a subconscious bias which is reducing your chances. The only exception to this warning 
is psychokinesis. In this case it does not matter how random your choices are: if you like, you 
can always pick your favourite symbol. In fact, it might be a good idea to do so, as it further 
aids your concentration. Note that in the DOS version, since you always pick one symbol for 
each psychokinesis test, it is quite possible to get large variations from random because each 
choice results in 25 “choices”.

Analyse Series
This analysis looks at your individual test results and uses the t-test to determine 

probabilities. You can specify all tests or any subset of them, provided there are two or more. 
The default is all tests. This analysis also determines your PsiQ.

The test analyses your overall score as well as your scores for each different option used 
in the tests. If more than one option has been used, for example different types of feedback, 
and there are sufficient numbers of each, then it will also compare your results under each 
option, and calculate how likely it is that any differences are due to chance.

Compare 2 Series
This test again uses the t-test to look at your individual tests, but compares two non-

overlapping subsets of your results. The minimum is 3 tests per subset, and the default is the 
first and second halves of your test history. It also compares the results for each different test 
option between each subset. This analysis is useful for measuring your progress, to see 
whether your scores are improving.

Graph Results
This shows a graphical representation of your test scores, giving you a useful visual 

indication of your progress. You can specify which tests you want to see, as well as various 
graph options.

Graph options are: how many data points to show per graph, what symbols to use for the 
data points and whether to connect them, and on some computers, what colour to use for the 
points. On computers which do not necessarily have bit-mapped graphics (e.g., the DOS 
version), you can also choose between bit-mapped and text graphs, i.e., ones drawn with text 
characters only. In this case, the graph can be appended to other text files, unlike the bit-
mapped graphic files.

Compare 2 Inputs
This does t-test comparisons of results you enter yourself. Its purpose is for comparing 

results which Esper does not do itself. For example, you and a friend might both be using the 
program and want to compare your scores. You have to enter the mean (average), standard 
deviation and number of tests for each case: these values are given by the Series analyses, so 
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simply copy them from there. The computer will then calculate the probability for you.

Show Raw Data
This prints out the actual score and option(s) for each test in the range you specify. The 

main use of this is if you want to do some sophisticated statistics, graphs or other manipulation 
of your results which Esper does not do. In that case, you simply need to export your raw 
data to a disk file. You can specify how to separate the data items (test number, score and 
option[s]) as needed by the program which you want to read the data: by commas, tabs or 
spaces. For example, a program in BASIC would probably want the data items separated by 
commas, while a word processor or spreadsheet would probably prefer tabs.
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Help
This gives you general information on Esper and its tests, plus details on aspects of Esper 

specific to your type of computer. You can read it on the screen and/or print it on your printer.

Payment Form
This lets you fill out your details for paying for and hence registering your copy of Esper. 

Simply fill out your details and your method of payment and email (if possible) or mail or fax 
the completed form with your payment to ThoughtWare at the address given on the form.

Register
When you pay, you will be sent registration information. Enter it using this menu item. 

Upon successful registration, the full features of Esper including saving your data, statistical 
analyses and PsiQ measurements, will become available.

System Configuration/Other Options
Further menu options may or may not be available, depending on your type of computer. 

If different configurations are available, such as with Apple II and IBM computers, then a 
system configuration menu item will be available for you to set your preferences. Information 
on these is provided by the Help menu item.
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Types of Test
Three kinds of statistics are used by Esper. The binomial and normal distributions are used 

for calculating the probabilities of total scores. The binomial statistic is an exact calculation 
used when the number of tests is below a certain limit, which varies between computers 
according to their precision of calculation. The normal statistic is used as an approximation 
when there are more tests than practicable for binomial calculation. The Student’s t-test is 
used for analysing a series of results or for comparing different series.

As the different tests use different assumptions, they may give different probabilities for 
the same data. Don’t worry if this is the case:  the differences will not be significant.

What Statistical Probabilities Mean
Statistical probability is the probability that your score, or an even more extreme score, 

could have been achieved simply by chance. The lower this probability, the more likely that 
the result is not due to chance but has a cause (in the case of Esper, the cause would be psi 
ability).

Thus, the probability is the chance of getting a score at least as good or better than what 
you got. It is calculated this way because the probability of getting exactly any particular 
score is quite low, but you must get some score: meaningful probabilities therefore must look 
at all scores as good or better than the one in question.

One-Tailed and Two-Tailed Tests
Statistical tests are generally “tailed”. This reflects the fact that results can differ in two 

directions: greater or lesser. A “1-tailed” probability is the chance of getting your score or 
better: for example “a score of 8 or higher”. A “2-tailed” probability is the chance of getting 
a score as extreme as yours or more so, in either direction: for example, “two averages 
differing by 3 or more”. In general, a “1–tailed” test is used if you expect the results to be in a 
particular direction, and a “2-tailed” test if you are interested in a difference in either 
direction. For example, in ESP tests you expect people with ESP to have above-average 
scores, so you would use a 1-tailed test; but when comparing two scores or determining the 
randomness of choices, there is no prior reason for expecting a particular direction of 
difference, and a 2-tailed test is used. As natural distributions tend to be at least approximately 
symmetrical, the probability from a 2-tailed test tends to be about twice that from a 1-tailed 
test.

Note that Esper uses a 1–tailed test even for scores which are below average, although it 
is not strictly acceptable procedure to use 1-tailed tests on results opposite to what you 
expect.

Binomial Distribution
The binomial distribution is a precise way to calculate probabilities when there are two 

possibilities, in this case “right” and “wrong” choices, which have probabilities of p and q  
respectively. In such cases, the exact probability of any combination of the two possibilities 
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can be calculated mathematically. The higher the number, the more calculations need to be 
performed, and the lower the starting number. This places a limit on the precision of the 
calculation, hence Esper only uses it up to a certain number of tests. As the number of tests 
increases, the binomial distribution approaches the normal distribution, so the latter is used for 
higher numbers.

The chance of getting Y out of k cards correct purely by chance is C(k,Y)pk–YqY. C(k,Y) 
is the combinatorial of k and Y, which is evaluated as k!/[Y! (k – Y)!], where ! means factorial. 
(The factorial of a number is the product of all integers from 1 to that number. For example, 5! 
= 5x4x3x2x1. By convention, 0! = 1). As statistical probabilities are concerned with scores 
greater than or equal to yours, calculations have to be done from Y to 25 and added up.

In practice, Esper calculates all the binomial probabilities from a score of 0 to one below 
your score. The chance of getting your score or higher is then one minus this sum 
(probabilities are always between 0 and 1). If it is a two-tailed test, then Esper remembers the 
sum up to (Y–4) and adds that to the answer: for example, a two–tailed test on 7 out of 25 
would be the sum of the probabilities of scores of 7 to 25, and 0 to 3 (i.e., deviations of 2 or 
more in either direction).

The actual means of calculation is to start from score 0, whose probability is P(0) = qk, and 
to generate each term of the distribution in turn by multiplying the previous term by [(k – j + 
1)/j]p/q = (k – j + 1)/(4j), where j is the new “score”. Thus, where P(n) is the probability of 
scoring n correct:

P(1) = P(0)k/4 = qkk/4

P(2) = P(1)(k–1)/8 = qkk(k–1)/32

P(3) = P(2)(k–2)/12 = qkk(k–1)(k–2)/384, etc.

See Sokal & Rohlf (1969) for further information.

Normal Distribution
The normal distribution calculation estimates the probabilities of scores in a large number 

of tests, for which exact calculations are impractical. The binomial distribution approaches the 
normal distribution as the number of test increases. The binomial distribution in the ESP tests 
has p=0.2 and q=0.8 (p is the probability of being right by chance, q the probability of being 
wrong), leading to a mean of p=0.2 and a standard deviation of √(pq/n) = √(0.16/n) (Sokal & 
Rohlf, 1969). If n is the total number of cards dealt and c is the total correct, the number of 
standard deviations achieved, X, is then X=|(c/n) – 0.2|/√(0.16/n), where |...| means the 
absolute value, i.e. ignore negative signs. This value is put into a formula used to 
approximate the probability with a maximum error of 7.5 x 10–8  (Rohlf & Sokal, 1969: Table P: 
Areas of the Normal Curve). The 1-tailed probability that X was achieved by chance, P(X) is 
then:

P(X) = 1/√(2π) e–X2/2 t(b1 + t(b2 + t(b3 + t(b4 + tb5)))), where

t = 1/(1 + pX)  [where p = 0.2316419]

√(2π) = 2.506628274631001

e = 2.718281828459045

b1 = +0.319381530

b2 = –0.356563782

b3 = +1.781477937
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b4 = –1.821255978

b5 = +1.330274429

The 2–tailed probability is simply twice the 1–tailed.

t-Test
The Student’s t-test (named after Student) calculates the actual variability of your scores, 

and from this determines the probabilities of your scores and of the differences between 
scores.

If n is the number of tests and x is the test score, then the mean (m) and variance (v) are 
given by the following formulae (the symbol ∑ means “the sum of all”, e.g., ∑x is the sum of 
all your scores):

    m = ∑x/n
    v  = [ ∑x2 – (∑x)2/n ]/(n – 1)

If the variance happens to be zero (all the scores in the tests being looked at are equal), 
then Esper uses the theoretical variance of a binomial population:

    v  = 25pq/n = 4/n

Using these values, a set of tests can be compared to the expected average score (five), or 
two sets of tests can be compared to each other.

To compare to the expected average (where df is “degrees of freedom”):

    t = | m – 5 |/√(v/n)
    df = n–1

To compare two sets, set1 and set2:

    t = | m1 – m2 |/√{[(v1(n1 –1) + v2(n2 –1))/(n1+n2 –2)] (n1+n2)/(n1 n2)}
    df = n1+n2 –2

The values of t and df are then used to look up the probability in a table of t-test values as  
published by Rohlf & Sokal (1969). The probability is multiplied by 2 for 2–tailed tests.

References:
Rohlf, F.J. & Sokal, R.R. (1969)  Statistical Tables. W.H. Freeman & Co, San Francisco

Sokal, R.R. & Rohlf, F.J. (1969)  Biometry. The Principles and Practice of Statistics in 
Biological Research. W.H. Freeman & Co, San Francisco
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